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AKVIS EXPLOSION 1.5 | ЭФФЕКТЫ РАЗРУШЕНИЯ И РАСПАДА

AKVIS Explosion добавляет на фотографии мощные эффекты разрушения и распада на частицы пыли и
песка. С помощью программы вы можете создать впечатляющую графику за несколько минут!

Explosion позволяет превратить часть изображения в песчаную бурю или взорвать объект на фотографии.
Добавьте эффект рассеивания, распыления, имитацию быстрого движения со светящимся следом, создайте
волшебный вихрь и другие впечатляющие образы.

Программа взрывает выбранную часть изображения и распыляет ее на облако летящих частиц: песчинки,
разнообразной формы осколки и др. Explosion предлагает эффективный и увлекательный способ создания
эффектов распада.
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С помощью AKVIS Explosion можно также подготовить стилизованные изображения, добавив листопад,
снегопад, звездопад, разместив на снимке парящие сердца или порхающих бабочек. Программа включает в
себя обширную библиотеку текстур и возможность загружать свой образец.

Создавайте удивительные произведения компьютерной графики, выразительные иллюстрации и
запоминающиеся рисунки. Добавляйте сюрреалистические эффекты на фотографии!
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Продукт представлен в виде самостоятельной программы (standalone) и в виде плагина (plugin) для
графических редакторов:  AliveColors, Adobe Photoshop, Corel PaintShop Pro и др.  Список совместимых
фоторедакторов.
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УСТАНОВКА ПРОГРАММЫ
Установка программы под Windows (на примере AKVIS Explosion)

Для установки программы на компьютер с системой Windows необходимо выполнить следующие действия:

Запустить программу установки двойным щелчком по файлу exe.
Выбрать язык программы и нажать кнопку ОК.
Ознакомиться с  Лицензионным Соглашением, при согласии с его условиями выбрать пункт "Я
принимаю условия лицензионного соглашения" ("I accept the term in the license agreement") и нажать
на кнопку Далее (Next).

Для установки плагина нужно выбрать из списка графический редактор (или редакторы), в который
будет устанавливаться плагин.

Для установки  версии standalone (отдельной программы) должен быть выбран соответствующий
вариант — Standalone.
Для создания ярлыка программы на рабочем столе должен быть выбран компонент Ярлык на рабочий
стол (Shortcut on Desktop).

Нажать на кнопку Далее (Next).
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Нажать кнопку Установить (Install).

Запустится процесс установки программы.
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Можно подписаться на рассылку AKVIS и получать новости об обновлениях программ, ссылки на
обучающие статьи и специальные предложения. Для этого введите свой адрес e-mail и подтвердите
согласие с политикой конфиденциальности.

Нажать кнопку Готово (Finish) для выхода из программы инсталляции.

После установки  программы AKVIS Explosion в главном меню  Start (Пуск) появится пункт  AKVIS ->
Explosion, a на рабочем столе  — ярлык программы AKVIS Explosion (если при установке было выбрано
создание ярлыка).

После установки плагина Explosion в меню фильтров (эффектов) редактора появится новый пункт AKVIS –
Explosion. Используйте эту команду для вызова плагина из графического редактора. Например, в Photoshop
выберите: Filter -> AKVIS -> Explosion.
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Внимание! Если плагин не установился в графический редактор автоматически, можно  подключить его
вручную. 
Обычно достаточно просто скопировать файл 8bf из папки AKVIS в папку Plug-ins графического редактора.
Например, для Adobe Photoshop CC скопируйте 8bf в папку Program Files\Common Files\Adobe\Plug-Ins\CC. 

 

AKVIS Explosion

9

https://akvis.com/ru/graphic-tips/add-plugins/index.php?utm_source=help


УСТАНОВКА ПРОГРАММЫ

 

Установка программы на Mac (на примере AKVIS Explosion)

Для установки программы AKVIS на Mac выполните следующие действия:

Открыть виртуальный диск dmg:

- akvis-explosion-app.dmg для установки версии Standalone (отдельной программы)

- akvis-explosion-plugin.dmg для установки версии Plugin.

Ознакомиться с Лицензионным соглашением и нажать кнопку Agree.

Откроется окно Finder с приложением AKVIS Explosion (в случае установки отдельной программы)
или, в случае установки плагина, с папкой AKVIS Explosion PlugIn.

 

Приложение AKVIS Explosion перетащите в папку Applications.

Папку AKVIS Explosion PlugIn (целиком!) — в папку с плагинами графического редактора.

Например, для установки в редакторы Photoshop CC 2020, CC 2019, CC 2018, CC 2017 и CC
2015.5 перетащите плагин в папку Library/Application Support/Adobe/Plug-Ins/CC,

для установки в Photoshop CC 2015 — в Applications/Adobe Photoshop CC 2015/Plug-ins,

для установки в Photoshop CS6 — в Applications/Adobe Photoshop CS6/Plug-Ins.
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После установки плагина Explosion в меню фильтров (эффектов) редактора появится новый пункт AKVIS –
> Explosion. Используйте эту команду для вызова плагина из графического редактора. Например, в
Photoshop выберите: Filter -> AKVIS -> Explosion.

Версия standalone (приложение) запускается обычным способом — двойным щелчком по файлу.
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АКТИВАЦИЯ ПРОГРАММЫ

Внимание! Ваш компьютер должен быть подключен к сети Интернет.

Если подключение к Интернет недоступно, ниже предлагается альтернативный способ активации.

 

Скачать установочный файл AKVIS Explosion (на странице программы или на странице загрузки).

Запустить скачанный файл и установить программу, следуя подсказкам мастера установки.

Запустить установленную программу. Окно  О программе  в се гда  показывается  при   запуске
незарегистрированной копии программы. Кроме того, окно О программе выводится при нажатии кнопки 

на Панели управления программы.

При работе с плагином в редакторе Adobe Photoshop окно О программе может быть вызвано на экран
выбором команды меню Help -> About Plug-In –> Explosion на Windows, Photoshop -> About Plug-In –>
Explosion на Mac.

 

При нажатии кнопки Попробовать откроется окно, где можно выбрать тип лицензии для ознакомления.
Если пробный период истёк, кнопка будет неактивна.

В течение ознакомительного периода (10 дней) доступна любая лицензия: Home (Plugin либо Standalone),
Deluxe или  Business. При выборе лицензии рядом будет отображен пояснительный текст с кратким
описанием данного типа лицензии. В зависимости от выбора будут доступны разные возможности AKVIS
Explosion.

Для получения более полной информации о версиях и лицензиях программы  AKVIS Explosion смотрите
сравнительную таблицу.

 

При нажатии кнопки Купить будет открыто окно, где необходимо указать приобретаемый тип лицензии.
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После выбора лицензии необходимо снова нажать кнопку Купить. В браузере откроется страница заказа,
где можно продолжить подбор программ либо приступить к оформлению покупки.

После заполнения формы и проведения денежной транзакции серийный номер будет выслан в течение
нескольких минут.

 

Чтобы зарегистрировать программу, нажать на кнопку Активировать. Откроется следующее окно:

В поле Имя пользователя ввести имя, на которое будет зарегистрирована программа.

В поле Серийный номер ввести номер, полученный после оплаты заказа.

Ниже выбрать способ активации - через прямое соединение с сервером или через электронную почту.

Прямое соединение с сервером

Рекомендуется данный способ активации, как наиболее быстрый.

Компьютер должен быть подключен к сети Интернет.

Нажать на кнопку Активировать для завершения активации.

Отправить запрос по e-mail

Eсли был выбран способ активации через e-mail, то при нажатии на кнопку  Активировать будет
автоматически создано письмо, которое, не редактируя, необходимо отправить по указанному адресу.

Если компьютер не подключен к Интернет, нужно записать созданное письмо на внешний носитель
(диск или "флешку") и отправить с другого компьютера, на котором есть доступ к сети. Все, что нам
нужно, уже будет записано в самом письме.

Если письмо не создается, просто  пришлите нам серийный номер (код лицензии) программы и
HardwareID (HWID) компьютера, на котором установлена программа.

В ответ будет получено письмо с вложенным файлом  Explosion.lic, который следует поместить в
папку, где хранится лицензионная информация о программе. Это папка AKVIS в Общих документах
пользователей:

Windows 7, Windows 8, Windows 10:
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Users\Public\Documents\AKVIS;

Mac:

Users/Shared/AKVIS или домашняя папка пользователя.

Активация программы завершена.

 

При желании можно произвести апгрейд до версии Home Deluxe или Business, доплатив разницу в цене.
Для этого в окне  О программе необходимо нажать кнопку  Улучшить (в зарегистрированной версии
появляется на месте кнопки Купить).

В открывшемся окне выбрать желаемую лицензию и нажать кнопку  Улучшить. При этом в браузере
откроется страница заказа, где можно оплатить выбранный апгрейд.

После оплаты вы получите сообщение, что ваша лицензия обновлена, после чего потребуется
переактивировать программу.

При нажатии кнопки Отменить происходит возврат в окно О программе.

При возникновении вопросов или проблем обратитесь в службу поддержки - support@akvis.com.
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ОПИСАНИЕ РАБОЧЕЙ ОБЛАСТИ

AKVIS Explosion может работать как отдельная программа или как плагин к графическому редактору.

Запустить отдельную программу можно следующими способами:

На компьютере с Windows - через меню Пуск либо с помощью одноименного ярлыка на рабочем
столе;

На компьютере с Mac - из папки Applications.

Для вызова плагина необходимо открыть изображение в редакторе, а затем выбрать пункт AKVIS –>
Explosion из меню фильтров.

При запуске программы вы увидите миниатюры с примерами эффектов. Кликните по любой из них, чтоб
показать настройки эффекта.

Вид рабочей области зависит от выбора режима редактирования на Панели управления: Экспресс или
Эксперт. В первом случае  интерфейс программы предельно упрощён и содержит минимальный набор
движков, позволяющих быстро получить удовлетворительный результат.
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Окно программы AKVIS Explosion (режим Экспресс)

При расширенном редактировании доступны все параметры и инструменты, описанные в соответствующих
разделах.
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Окно программы AKVIS Explosion (режим Эксперт)

 

Элементы окна программы:

Левую часть окна программы AKVIS Explosion занимает Окно изображения с закладками До и После. В
закладке До находятся входные данные, в закладке После - последний результат. Переключаться между
ними можно с помощью клика левой кнопки мыши по названию закладки.

В верхней части окна расположена Панель управления с кнопками:

Кнопка   позволяет перейти на домашнюю страницу программы AKVIS Explosion.

Кнопка   (только в отдельной программе) предназначена для открытия изображения, к  которому

будут применяться эффекты. Открыть изображение можно с помощью горячих клавиш  Ctrl+O   н а
Windows, ⌘ +O  на Mac.

Кнопка   (только в отдельной программе) предназначена для сохранения отредактированного

изображения на диск. Диалог сохранения файла вызывается нажатием клавиш  Ctrl+S  на Windows,
⌘ +S  на Mac.

Кнопка   (только в отдельной программе) предназначена для  вывода изображения на печать.

Быстрая отправка на печать производится нажатием клавиш Ctrl+P  на Windows, ⌘ +P  на Mac.

Кнопка   позволяет опубликовать результат на своей странице в социальной сети.

Кнопка   предназначена для загрузки из файла сохраненных ранее пресетов.

Кнопка   предназначена для записи пресетов в отдельный файл с расширением .explosion. В файл

можно сохранить любое количество пресетов.

Кнопка   предназначена для загрузки файла с выделением (.stroke).
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Кнопка   предназначена для сохранения выделения в отдельный файл с расширением .stroke.

Кнопка   /  включает и отключает показ областей выделения.

Кнопка   предназначена для отмены последнего действия. Если нажать на эту кнопку несколько

раз, будут отменены несколько последних действий. Отменить действие можно с клавиатуры с
помощью комбинации клавиш Ctrl+Z  на Windows, ⌘ +Z  на Mac.
Кнопка   позволяет восстановить действие, отмененное командой  .

Восстановить действие можно с клавиатуры нажатием клавиш Ctrl+Y  на Windows, ⌘ +Y  на Mac.
Кнопка   запускает процесс обработки изображения. Запустить обработку с клавиатуры можно

нажатием клавиш Ctrl+R  на Windows, ⌘ +R  на Mac.

Кнопка   (только в плагине) предназначена для применения результатов и закрытия окна плагина.

Кнопка   предназначена для вызова сведений о программе.

Кнопка   (либо клавиша F1 ) предназначена для вызова справки помощи по программе.

Кнопка   вызывает диалог изменения Настроек программы.

Кнопка   вызывает панель оповещений со свежими новостями о программе.

Слева от  Окна изображения находится  Панель инструментов. Параметры выбранного инструмента
показаны в окне, всплывающем по щелчку правой кнопки мыши.

 

Инструменты выделения

Кисть выделения . С помощью данного инструмента обводятся или закрашиваются области

изображения, к которым должен быть применен эффект. Размер инструмента можно изменить в окне,
которое всплывает по щелчку правой кнопки мыши.

Для получения прямых линий при рисовании удерживайте клавишу Shift .

Свободное выделение . С помощью данного инструмента можно выделить фрагмент произвольной

формы. При отпускании левой кнопки мыши контур замыкается.
Ластик . С помощью данного инструмента можно отредактировать выделение. Размер инструмента

можно изменить в окне, которое всплывает по щелчку правой кнопки мышки.
Заливка . Данный инструмент используется для выделения больших областей, требующих

обработки. Область должна быть обведена замкнутым контуром с помощью  Кисти выделения;   в
противном случае изображение будет выделено полностью.

Примечание: Инструмент  Заливка можно использовать в "режиме ластика", чтобы снять
выделение. Для этого нужно щелкнуть левой кнопкой мыши, зажав клавишу  Ctrl  на Windows,
⌘  на Mac.

Трансформация . С помощью данного инструмента можно менять pазмер и положение выделения.

Инструменты дополнительной обработки

Кнопка   активирует инструмент  Кисть возврата, который восстанавливает изображение до

исходного состояния. Инструмент доступен только для лицензии Home Deluxe и Business.

Внимание! При каждом новом расчёте   результат применения инструмента сбрасывается.

Bспомогательные инструменты

Кнопка   активирует инструмент Рука, который позволяет прокручивать фотографию, когда она не

помещается в Окне изображения при выбранном масштабе. Для прокрутки необходимо нажать на
кнопку, подвести курсор к изображению и, удерживая левую кнопку мыши нажатой, переместить в
нужную сторону.
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Двойным щелчком по кнопке   изображение масштабируется под размер окна программы.

Кнопка   активирует инструмент Лупа, предназначенный для изменения масштаба изображения. Для

увеличения масштаба необходимо щёлкнуть левой кнопкой мыши по изображению в окне программы.
Для уменьшения масштаба изображения щелчок производится с нажатой клавишей Alt . Для быстрого
вызова инструмента используется клавиша Z .

Двойным щелчком по кнопке   можно развернуть изображение в натуральную величину (100%).

Перемещение по изображению и масштабирование осуществляется с помощью  Навигатора. Рамкой в
Навигаторе отмечена та часть изображения, которая в данный момент является видимой в  Окне
изображения; области за пределами рамки будут затенены. Рамку можно перетаскивать, меняя видимую
часть изображения. Для перемещения рамки необходимо поместить курсор внутрь рамки и, удерживая
левую кнопку мыши, выполнить перетаскивание.

Навигатор

Под Навигатором расположены кнопки фиксации результата:

Кнопка   копирует текущий результат в закладку До. Поверх можно накладывать новые эффекты.

Кнопка   удаляет эффекты с закладки До, позволяя работать с оригиналом.

Кнопка  . При включении эффект накладывается поверх исходной картинки. При выключении будет

использован прозрачный фон.

Для прокрутки изображения в Окне изображения можно использовать полосы прокрутки или нажать на
пробел и перетаскивать изображение левой кнопкой мыши. Прокруткой колёсика мыши изображение можно
перемещать вверх-вниз, удерживая  Ctrl  на Windows,  ⌘  на Mac – вправо-влево, удерживая  Alt   н а
Windows, Option  на Mac − масштабировать. При щелчке правой кнопкой мыши на полосе прокрутки
появляется меню быстрых перемещений.

Масштабировать изображение в Окне изображения можно с помощью кнопок   и  , а также с помощью
ползунка. При щелчке по кнопке   или перемещении ползунка вправо происходит увеличение масштаба
изображения; при щелчке по кнопке   или перемещении ползунка влево происходит уменьшение масштаба
изображения.

Также масштаб изображения изменится, если ввести в поле масштабирования новый масштабный
коэффициент. Часто используемые масштабы помещены в выпадающее меню поля масштабирования.

Для увеличения масштаба изображения можно воспользоваться клавиатурными сокращениями: +  и Ctrl++

на Windows, ⌘ ++  на Mac, для уменьшения масштаба -  и Ctrl+-  на Windows, ⌘ +-  на Mac.
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Под Навигатором расположена Панель настроек со списком эффектов и параметрами, которые можно
настраивать.

На панели Пресеты понравившиеся настройки программы можно сохранить как пресет и использовать в
дальнейшем.

Также можно пользоваться подсказкой - кратким описанием параметров и кнопок, на которые наводится
курсор. Изменить местоположение окна подсказки либо скрыть его совсем можно в Настройках программы.
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КАК РАБОТАТЬ С ПРОГРАММОЙ

AKVIS Explosion может работать как отдельная программа или как плагин к графическому редактору.

Для добавления эффекта необходимо выполнить следующие действия:

Шаг 1. Открыть изображение.

- В отдельной программе (файл в формате TIFF, BMP, JPEG, PNG или RAW):

Диалоговое окно  Открыть изображение можно вызвать сразу после запуска программы с
помощью двойного щелчка мыши в области Окна изображения или кнопкой   на Панели

управления. Кроме того, можно перетащить ярлык изображения в открытое окно программы или
редактора.

- При работе с плагином:

В графическом редакторе с помощью команды меню Файл -> Открыть или сочетания клавиш
Ctrl+O  на Windows, ⌘ +O  на Mac вызвать диалог открытия изображения и выбрать требуемый
файл.

Вызвать плагин AKVIS Explosion с помощью команды меню:

в AliveColors: Effects -> AKVIS -> Explosion; 
в Adobe Photoshop: Filter –> AKVIS –> Explosion; 
в Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Explosion.

Вид рабочей области зависит от выбора режима редактирования на Панели управления: Экспресс
или  Эксперт. В первом случае интерфейс программы предельно упрощён и содержит минимальный
набор движков, позволяющих быстро получить удовлетворительный результат. При расширенном
редактировании доступны все параметры и инструменты, описанные в соответствующих разделах.

Изображение для обработки
Шаг 2. На Панели настроек из выпадающего списка выбрать вид Эффекта.
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Программа предлагает следующие эффекты: Песок и Частицы.

Шаг 3. Отметить область эффекта с помощью инструментов выделения.

Параметры инструментов настраиваются в окне, всплывающем по щелчку правой кнопки мыши. Для
получения прямых линий при рисовании удерживайте клавишу Shift .

Область эффекта

Размер и положение выделения можно менять с помощью кнопки Трансформация . Удерживайте

Shift , чтобы сохранить пропорции объекта. При зажатой клавише  Alt  угол поворота изменяется с
шагом в пять градусов, а масштабирование происходит от центра.

Рекомендуется сохранить выделение в файл с расширением .stroke с помощью кнопки   - тогда на

любом этапе работы в последующем можно подгрузить их к картинке (кнопка  ).

Шаг 4. По умолчанию, в программе используется Автоматический режим обработки. Если он отключён,
обработку изображения можно запустить кнопкой  . Результат будет показан на закладке После.
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Обработка изображения с настройками по умолчанию
Шаг 5. Если результат не устраивает, изменить параметры эффекта на  Панели настроек. Снова
запустить расчёт (кнопка  ).
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Обработка изображения после настройки параметров
Шаг 6. При желании результат можно скомбинировать с другими эффектами. Зафиксируйте результат 

 и разрушьте новую область. Изменения будут накапливаться, создавая более интересный эффект.
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Шаг 7. В версии  Home Deluxe и Business имеется возможность вручную доработать изображение с
помощью  Кисти возврата . Данный инструмент позволяет  изменить область применения и

интенсивность проявления эффекта, восстановить исходный вид изображения на выбранном участке и
т. д.

Внимание! При каждом новом расчёте   результат применения инструмента сбрасывается.
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Параметры инструмента:

- Размер (1-1000) - диаметр инструмента.
- Жёсткость (0-100%) - степень размытости внешнего края. Чем больше значение параметра,
тем сильнее загрубляется край инструмента.
- Сила (1-100%) - степень воздействия на изображение.

Шаг 8. Понравившиеся настройки обработки можно сохранить как пресет и использовать в
дальнейшем. Для сохранения настроек необходимо на панели Пресеты ввести имя пресета и нажать
на кнопку Сохранить.

Настройки выбранного пресета являются значениями по умолчанию, и при следующем запуске
программы все параметры примут эти значения. Если значения параметров были изменены, то для
возвращения исходных настроек используется кнопка Сброс.

Для удаления пресета необходимо выбрать его из списка пресетов и нажать на кнопку Удалить.

Для того чтобы обработать изображение с помощью пресета, необходимо выбрать соответствующий
пресет из списка и нажать на кнопку  .

Шаг 9. При желании можно опубликовать результат на своей странице в социальной сети (кнопка 

).

В стандалон-версии AKVIS Explosion есть возможность распечатать изображение.

Шаг 10. Сохранить изображение.

- В отдельной программе:

Нажать на кнопку   и в диалоговом окне  Сохранить изображение ввести имя файла,

указать формат (TIFF, BMP, JPEG или PNG) и выбрать каталог, в который необходимо сохранить
файл.

Чтобы сохранить только эффект, отключите исходный фон   и сохраните изображение на

Эффект Для уменьшения эффекта использована
Кисть возврата
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прозрачном фоне как PNG файл.

- При работе с плагином:

Нажать на кнопку  , чтобы применить результат обработки. Окно плагина AKVIS Explosion

закроется, и изображение появится в окне графического редактора.

Вызвать диалог сохранения файла командой меню Файл -> Сохранить как, ввести имя файла,
указать формат и выбрать каталог, в который необходимо сохранить файл.

Результат обработки
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РАБОТА С ПРЕСЕТАМИ

Программа  AKVIS Explosion позволяет сохранить понравившиеся настройки обработки как пресет и
использовать их в дальнейшем.

Пресеты могут содержать параметры всех закладок. Если настройки были изменены, вернуть их можно
кнопкой Сброс.

Для сохранения настроек необходимо на Панели настроек (справа) в поле Пресеты ввести имя пресета и
нажать на кнопку Сохранить.

Для удаления пресета необходимо выбрать его в списке и нажать на кнопку Удалить.

 

Пресеты можно сохранить в отдельный файл с расширением  .explosion. Для записи пресетов в файл

нажмите  . Для загрузки пресетов из файла нажмите  .

Более подробно об импорте и экспорте пресетов.
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НАСТРОЙКИ ПРОГРАММЫ

Диалог изменения настроек программы вызывается кнопкой   и имеет вид:

Язык программы. Для переключения интерфейса программы на другой язык необходимо выбрать язык
из выпадающего списка.
Масштаб интерфейса. В списке можно выбрать размер элементов интерфейса. При выборе значения
Авто масштаб интерфейса автоматически подстраивается под разрешение экрана.
Интерфейс. Переключаясь между цветами, можно выбрать стиль оформления программы - светло-
серый, серый или темный.
Масштаб изображения при загрузке. Способ отображения открываемого файла.

- изображение масштабируется Под размер окна. Масштаб подгоняется так, чтобы оно было
полностью видимым в Окне изображения;

- при значении 100% изображение не масштабируется. В большинстве случаев при открытии в
масштабе 100% в окне программы будет показана лишь часть изображения.

Чек-бокс  Выбор эффекта при запуске включает и отключает показ миниатюр с примерами
эффектов.
 Чек-бокс Автоматический режим. В автоматическом режиме любое изменение настроек или области
эффекта запускает процесс обработки. При работе в обычном режиме обработка начинается после
нажатия кнопки  .

Выделение. Внешний вид областей выделения.

- "Марширующие муравьи". Области выделения обрамляются кривой в виде "бегущей"
пунктирной линии.

- Заполнение цветом. Области выделения будут залиты цветом. По умолчанию Цвет заливки
красный, но его можно изменить, щелкнув по цветовой пластине и выбрав цвет из стандартного
диалога.
Степень просвечивания областей выделения при заполнении цветом можно регулировать,
изменяя параметр Непрозрачность.
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Отображение подсказок. В данном блоке задаётся местоположение окна подсказок.

- Слева под окном изображения;
- Справа на панели настроек;
- Не отображать.

Число запоминаемых действий (5-100). Размер стека памяти. Ограничение количества состояний,
которые можно откатить с помощью кнопок   и  .

Последние открытые файлы. Количество файлов, отображаемых в списке недавно открытых
документов при правом клике мышью по кнопке   (сортированы по времени открытия).

Максимальная длина списка - 30 файлов.
Чек-бокс  Системный диалог открытия/сохранения. При включенном чек-боксе для открытия/
сохранения файлов используются диалоги операционной системы, при неактивном - программные
диалоги.
Чек-бокс  Закрепить панель управления блокирует возможность сворачивания панели.
Разблокированную панель можно сворачивать и разворачивать щелчком по маленькой треугольной
стрелке. Свёрнутая панель всплывает при наведении курсора.

Для принятия изменений в окне Настройки нажмите ОК.

Вернуть исходные значения параметров можно нажатием кнопки По умолчанию.
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ПЕЧАТЬ ИЗОБРАЖЕНИЙ

Режим Печать отвечает за подготовку изображений к распечатке на принтере. Перейти в режим печати

можно нажатием кнопки   на Панели управления.

Режим печати

Настроить печать выбранной фотографии можно с помощью параметров на Панели настроек:

В первом блоке из списка доступных принтеров выбрать нужный и указать необходимое разрешение, а
также задать количество печатных копий.

В блоке Ориентация страницы задать положение листа при печати: Альбомная - лист расположен
горизонтально или Книжная - лист расположен вертикально.

При нажатии на кнопку  Параметры страницы открывается диалоговое окно, в котором можно
выбрать размер и ориентацию бумаги при печати, а также задать ширину полей печати.

Нажатием кнопки Сброс полей можно вернуть полям страницы исходные размеры.

В следующем блоке можно настроить размер изображения для печати с помощью параметров
Масштаб, Ширина, Высота и Под размер страницы. Они не влияют на изображение, а только на
его печатную копию. Изменить размер печатной копии можно либо указав Масштаб изображения в %,
либо задав новые значения для параметров Ширина и Высота.

Чтобы распечатать изображение во всю страницу, следует выбрать чек-бокс Под размер страницы.
Если чек-бокс неактивен, то положение картинки можно задать с помощью стрелок справа или
перетаскиванием мышью.

В блоке Рамка можно задать ширину и цвет рамки вокруг изображения.

В блоке Цветной фон с помощью цветовой пластины можно вызвать стандартный диалог выбора цвета
и задать цвет страницы.

AKVIS Explosion

31



В закладке Страница можно настроить расположение одной или нескольких копий изображения на
одной странице.

Печать страницы
С помощью параметра  Копии указать количество копий обработанной фотографии на одной
странице.
Параметрами  По горизонтали  и   По вертикали задать количество строк и столбцов для
размещения фотографий.
С помощью параметра Отступ задать ширину отступа между копиями фотографий.

На вкладке  Постер можно настроить печать одного изображения на нескольких страницах для
последующего объединения в одно большое полотно.

Печать постера
Чек-бокс Страницы. При активном чек-боксе в поле справа можно задать количество страниц,
на которое будет поделена фотография. Масштаб изображения изменится, чтобы максимально
заполнить все страницы. При неактивном - программа автоматически подберет оптимальное
число листов в соответствии с фактическим размером изображения (масштаб = 100%).
Чек-бокс Поля для клея. При активном чек-боксе в поле справа можно задать ширину отступов
для склеивания листов. Отступы будут оставлены с правого и нижнего краев при печати
страницы.
Чек-бокс Нумерация страниц. При активном чек-боксе на полях страницы будет напечатан
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номер ее позиции в столбце и строке.
Чек-бокс Линии отреза. При активном чек-боксе на полях страниц будут напечатаны линии, по
которым можно отрезать лишние части распечатанных листов.

Для печати изображения с учетом настроенных параметров нажать на кнопку  Печать. Для выхода из
режима печати нажать на кнопку Отмена.

При нажатии кнопки  Опции... будет открыт системный диалог, где можно произвести расширенную
настройку и отправить документ на печать.
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ПЕСОК

С помощью данного эффекта можно распылить изображение на крупинки песка и осколки.

Эффект позволяет разрушить выделенную область. Для выделения используйте инструменты:  Кисть
выделения , Свободное выделение , Ластик , Заливка . С помощью инструмента

Трансформация  можно можно менять pазмер и положение выделения.

 

Параметры эффекта:

В выпадающем списке Наложение эффекта можно указать способ взаимодействия эффекта с фоном.
Всего в программе предусмотрено 9 режимов наложения.

Угол (от -180 до 180). Направление эффекта.

Песчаный взрыв

Наложение эффекта (режим Нормальный) Наложение эффекта (режим Умножение)
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Угол разлёта (от -5 до 35). Сужение и расширение конуса разлёта.

В создании эффекта участвуют  Струи, Частицы  и   Дым. Для струй и дыма можно отрегулировать
прозрачность.

В выпадающем списке  Наложение слоя можно указать способ взаимодействия эффекта с другими
эффектами в области пересечения.

Угол = 25 Угол = 173

Угол разлёта = -5 Угол разлёта = 35

Струи Частицы Дым
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Закладка Струи

Дистанция (10-300). Дальность распространения эффекта.

Размер завихрений струй (5-80). Величина искажений структуры.

Размытие (7-250). Интенсивность сглаживания цветов.

Наложение слоя (режим Жёсткий свет) Для сравнения:
Наложение эффекта (режим Жёсткий свет)

Дистанция = 25 Дистанция = 125

Размер завихрений струй = 10 Размер завихрений струй = 30
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Убывание (0-90). Уменьшение эффекта по краю.

Чек-бокс Выпрямление. При включении чек-бокса волнистая структура сглаживается.

Зернистость (0-100). К эффекту добавляются шумовые вкрапления.

Размытие = 20 Размытие = 200

Убывание = 20 Убывание = 85

Чек-бокс "Выпрямление" неактивен Чек-бокс "Выпрямление" активен
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Кнопка Случайное число генерирует другое распределение волн.

Закладка Частицы

Дистанция (10-300). Дальность вылета частиц.

Растяжение (10-30). Вытягивание частиц в направлении эффекта.

Размер частиц (1-100). Величина частиц.

Зернистость = 15 Зернистость = 100

Дистанция = 25 Дистанция = 125

Растяжение = 10 Растяжение = 30
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Вариации размера (0-80). Разница между размерами частиц.

Плотность (20-40). Количество частиц.

Убывание (0-90). Уменьшение размера частиц по краю. При 0 все частицы одинаковы.

Размер частиц = 1 Размер частиц = 50

Вариации размера = 0 Вариации размера = 80

Плотность = 20 Плотность = 40
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Кнопка Случайное число генерирует другое распределение частиц.

Закладка Дым

Дистанция (10-300). Дальность распространения дыма.

Искажение (10-100). Степень деформации дымового следа.

Размытие (15-50). Интенсивность сглаживания цветов.

Убывание = 0 Убывание = 90

Дистанция = 15 Дистанция = 100

Искажение = 10 Искажение = 70
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Размер завихрений дыма (5-30). Величина искажений структуры.

Затемнение (0-100). Тёмные участки дыма начинают преобладать над светлыми.

Убывание (0-90). Уменьшение эффекта по краю.

Размытие = 15 Размытие = 40

Размер завихрений дыма = 5 Размер завихрений дыма = 15

Затемнение = 10 Затемнение = 80
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Кнопка Случайное число генерирует новое распределение дыма в разрушенной области.

 

Убывание = 0 Убывание = 90
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РАССЫПАНИЕ НА ЧАСТИЦЫ

Фантастический эффект рассеивания превращает часть изображения в россыпь летящих частиц.

Эффект позволяет разрушить выделенную область. Для выделения используйте инструменты:  Кисть
выделения , Свободное выделение , Ластик , Заливка . С помощью инструмента

Трансформация  можно можно менять pазмер и положение выделения.

 

Рассыпание на частицы

Параметры эффекта:

В выпадающем списке Наложение эффекта можно указать способ взаимодействия эффекта с фоном.
Всего в программе предусмотрено 9 режимов наложения.
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Угол (от -180 до 180). Направление, в котором летят частицы (без учета ветра).

Чек-бокс  Действие ветра.  При включении чек-бокса частицы смещаются под действием
дополнительного эффекта (см. закладку Ветер).

Направление ветра (от -180 до 180). Угол, в сторону которого отклоняются летящие частицы.

Наложение эффекта (режим Нормальный) Наложение эффекта (режим Отбеливание)

Угол = -153 Угол = 5

Без действия ветра
(чек-бокс неактивен)

Влияние ветра
(чек-бокс активен)
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Чек-бокс  Обработка по частям. В режиме обработки по частям каждая область разрушается
независимо от других, образуя больше частиц (при этом расчёт замедляется).

В выпадающем списке Наложение слоя можно указать способ взаимодействия эффекта с другими
эффектами в области пересечения.

Закладка Частицы

Размер (5-100). Величина частиц.

Направление ветра = -55 Направление ветра = 135

Выделение Без обработки по частям
(чек-бокс неактивен)

Обработка по частям
(чек-бокс активен)

Наложение слоя (режим Отбеливание) Для сравнения:
Наложение эффекта (режим Отбеливание)
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Дистанция (100-3000). Дальность вылета частиц.

Плотность (15-800). Количество частиц.

Поворот частиц (от -180 до 180). Угол разворота частиц вокруг своей оси.

Размер = 5 Размер = 50

Дистанция = 150 Дистанция = 500

Плотность = 100 Плотность = 700
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Угол разлёта (0-60). Ширина конуса разлёта.

Убывание (0-100). Уменьшение размера частиц по краю. При 0 все частицы одинаковы.

Закладка Текстура

В выпадающем списке Наложение текстуры можно задать способ наложения частиц друг на друга.

Поворот частиц = 0 Поворот частиц = 40

Угол разлёта = 0 Угол разлёта = 30

Убывание = 0 Убывание = 100
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Форму частиц можно выбрать из заданных образцов (круг, квадрат, сердечко и т. д.) или загрузить
свою.

Текстура частиц формируется двумя способами:

С изображения. Частицы представляют собой разрушенные куски исходного изображения.

С помощью цвета. Частицы будут перекрашены в указанный цвет.

Размытие движения (0-20). Сила эффекта.

Наложение текстуры (режим Нормальный) Наложение текстуры (режим Отбеливание)

Треугольники Звёзды

Текстура заполнена цветом объекта Текстура заполнена жёлтым цветом
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Закладка Ветер

Сила (10-3000). Интенсивность действия ветра.

Затухание (0-100). Размер области, в которой эффект ветра уменьшается. При 0 затухания нет, при
100 ослабление максимально.

Турбулентность (0-3000). Рассеивание потока частиц в направлении ветра.

Размытие движения = 2 Размытие движения = 10

Сила = 500 Сила = 2500

Затухание = 0 Затухание = 100
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Неоднородность (5-20). Чередование разреженных областей и сгущений. Этот параметр работает,
когда есть Турбулентность.

Закладка Вариации:

Вариации размера (0-70). Разница между размерами частиц.

Вариации поворота (0-180). Разница в углах поворота частиц.

Турбулентность = 200 Турбулентность = 3200

Неоднородность = 5 Неоднородность = 20

Вариации размера = 0 Вариации размера = 70
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Вариации формы (0-60). Разница в коэффициентах сжатия частиц.

Вариации оттенка (0-125). Диапазон изменения цвета.

Вариации насыщенности (0-30). Диапазон изменения насыщенности цвета.

Вариации поворота = 0 Вариации поворота = 70

Вариации формы = 0 Вариации формы = 60

Вариации оттенка = 0 Вариации оттенка = 125
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Вариации яркости (0-30). Диапазон изменения яркости цвета.

Кнопка Случайное число генерирует новое распределение частиц в разрушенной области.

 

Вариации насыщенности = 0 Вариации насыщенности = 30

Вариации яркости = 0 Вариации яркости = 30
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ЭФФЕКТ ЗОЛОТОЙ ПЫЛИ

Программа  AKVIS Explosion позволяет с легкостью создавать разнообразные эффекты разрушения и
рассеивания. Например, вы можете использовать режим Песок, чтобы имитировать эффект золотой пыли.

Эффект золотой пыли
(открыть в большом размере)

Шаг 1. Запустите  AKVIS Explosion, выберите эффект  Песок и откройте изображение, используя
кнопку  .
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Изображение в программе AKVIS Explosion
Шаг 2. Отметьте области разрушения, используя  Кисть выделения . Если включен  режим

автозапуска, изображение обрабатывается автоматически. В противном случае нажмите  , чтобы

запустить обработку.

Выделение
Шаг 3. Настройте параметры эффекта. Выберите опцию  Линейное отбеливание для режима
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наложения эффектов.

Предварительный результат

Сохраните предварительный результат, нажав на кнопку  . Затем снова откройте изображение в

программе с помощью кнопки  .

Шаг 4. Повторно обработайте изображение, используя другие настройки. Для этого создайте новое
выделение и настройте параметры. Выберите Нормальный режим наложения эффектов.

Вы можете экспериментировать с различными режимами смешивания и комбинировать различные
настройки, пока не получите желаемый результат.
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Конечный результат

Шаг 5. Сохраните изображение   и наслаждайтесь полученным результатом!
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ЛЕТНЯЯ ФАНТАЗИЯ

Программу AKVIS Explosion можно использовать не только для разрушения изображений, но и для создания
простых фантазийных эффектов.

Исходное изображение Результат

Шаг 1. Запустите программу, выберите эффект Частицы и откройте изображение.

Изображение в программе AKVIS Explosion
Шаг 2. Первое, с чего следует начать работу - создать выделение. Инструментом Кисть выделения 

 отметьте область, где должен возникнуть эффект.

Если вы работаете в режиме автоматического расчёта, то рядом с выделением появится россыпь
частиц. Если авторасчёт отключён, результат обработки появится после нажатия  .
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Выделение
Шаг 3. Так как отмечены сразу три области, можно включить чек-бокс Пошаговая обработка, чтобы
появилось больше частиц.
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Режим пошаговой обработки

Форма частиц может быть любой - например, бабочки, чтоб подчеркнуть летнее настроение картинки.
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Шаг 4. Если эффект кажется недостаточно красивым, перейдите в режим  Эксперт для настройки
параметров или воспользуйтесь готовыми пресетами от AKVIS.

Подбор параметров эффекта

Шаг 5. Сохраните изображение (кнопка  ) и наслаждайтесь результатом!

Результат
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ПРОГРАММЫ КОМПАНИИ АКВИС

 

AKVIS AirBrush — Аэрографический рисунок из фотографии

(Windows | Mac)

AKVIS AirBrush позволяет превратить фотографию в рисунок в технике аэрография. Программа действует
как художественный фильтр, изменяя изображение и превращая его в аэрографический рисунок в
соответствии с выбранными настройками. Подробнее…

 

AKVIS ArtSuite — Эффекты и рамки для фотографий

(Windows | Mac)

AKVIS ArtSuite — коллекция рамок и эффектов для оформления фотографий. ArtSuite содержит множество
готовых шаблонов и богатую Библиотеку образцов и текстур и позволяет получить практически бесконечное
количество вариантов эффектов. Подробнее…
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AKVIS ArtWork — Имитация художественных стилей

(Windows | Mac)

AKVIS ArtWork имитирует художественные стили и техники живописи, создавая произведение искусства. В
программе представлены эффекты:  Масляная живопись, Акварель, Гуашь, Комикс, Перо и чернила,
Линогравюра, Пастель и Пуантилизм. Подробнее…
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AKVIS Chameleon — Создание коллажей

(Windows | Mac)

AKVIS Chameleon  —   программа для создания коллажей, реалистичных и фантастических. Chameleon
экономит время и силы, так как не требует точного выделения объектов, автоматически сглаживает границы
и подбирает цветовую гамму "вставки" к цветам фона. Подробнее…

 

AKVIS Charcoal — Рисунок углем и мелом

(Windows | Mac)

AKVIS Charcoal позволяет преобразовать фотографию в рисунок, выполненный углём и мелом. Изменяя
цвета материалов и бумаги, можно получить массу самых разнообразных эффектов, например, рисунок
сангиной. Подробнее…

 

AKVIS Coloriage — Раскрашивание изображений

(Windows | Mac)

AKVIS Coloriage позволяет раскрашивать черно-белые фотографии и заменять цвет на цветных
изображениях, выполнять выборочное раскрашивание и обесцвечивание.  С помощью программы можно
вернуть к жизни старые снимки и придать современной фотографии винтажный вид. Подробнее…
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AKVIS Decorator — Замена текстуры и перекраска поверхности

(Windows | Mac)

AKVIS Decorator — программа для изменения поверхности объекта. Decorator позволяет заменить текстуру
либо цвет выбранного объекта. При наложении текстуры сохраняется объем,  изгибы, тени исходного
изображения. В программе представлена богатая Библиотека текстур:  образцы поверхностей дерева,
металла, камня, травы, тканей и др. Подробнее…

 

AKVIS Draw — Создание карандашного эскиза

(Windows | Mac)

AKVIS Draw позволяет превратить фотографию в эскиз, выполненный простым карандашом. Программа
имитирует видение и подход истинного художника. С помощью AKVIS Draw вы можете придать любому
изображению вид быстрого карандашного наброска. Подробнее…
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AKVIS Enhancer — Фотокоррекция с усилением детализации

(Windows | Mac)

AKVIS Enhancer — программа для обработки фотографий с усилением детализации изображения. Программа
позволяет проявить детали в светлых и темных областях, улучшить резкость и контрастность изображения,
добавить яркость, отредактировать отдельные цветовые области. Программа работает в трех режимах:
Улучшение деталей, Допечатная обработка и Тоновая коррекция. Подробнее…

 

AKVIS Explosion — Эффекты разрушения и распада

(Windows | Mac)

AKVIS Explosion добавляет на фотографии эффекты разрушения. Программа позволяет распылить объект на
осколки, превратить часть изображения в россыпь летящих частиц, создать песчаную бурю, имитировать
взрыв и другие эффекты распада. Подробнее…

 

AKVIS Frames — Готовые рамки для фотографий

(Windows | Mac)

AKVIS Frames — бесплатная программа для оформления фотографий. Программа предназначена для работы
с пакетами рамок AKVIS. Вы можете украсить свои снимки эксклюзивными стильными рамками! Подробнее…
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AKVIS HDRFactory — Расширение динамического диапазона

(Windows | Mac)

AKVIS HDRFactory — программа для создания изображений с расширенным динамическим диапазоном (HDR)
из одного или нескольких снимков, а также для коррекции яркости, контрастности, насыщенности.
HDRFactory наполнит жизнью и цветом ваши фотографии! Подробнее…

 

AKVIS LightShop — Световые и звездные эффекты

(Windows | Mac)

AKVIS LightShop добавляет световые эффекты на изображение.  С помощью программы можно создать
любого вида и формы свечения, добавить на фотографию лучи, ореолы, вспышки, молнии, блики на объекты,
закат или фейерверк. LightShop украсит снимок, оживит пейзаж, изменит время суток и погоду. Подробнее…
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AKVIS Magnifier AI — Увеличение и уменьшение изображений

(Windows | Mac)

AKVIS Magnifier AI изменяет размер изображения без потери качества. Благодаря использованию
нейросетей программа обеспечивает многократное увеличение и создает изображения высокого разрешения
и постеры огромных размеров. Подробнее…

 

AKVIS MakeUp — Ретушь портретных фотографий

(Windows | Mac)

AKVIS MakeUp — программа для исправления портретных фотографий. MakeUp улучшает портрет, устраняя
мелкие дефекты с поверхности кожи и придавая лицу сияние, чистоту и гладкость. Программа способна
превратить обычный снимок в фотографию с обложки, создать стильный образ и даже получить изображение
в "высоком ключе". Подробнее…
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AKVIS NatureArt — Природные явления на ваших фотографиях

(Windows | Mac)

AKVIS NatureArt — коллекция уникальных эффектов, имитирующих природные явления. В программу
включены эффекты: Дождь

 

AKVIS Neon — Рисунок светящимися линиями

(Windows | Mac)

AKVIS Neon превращает фотографию в яркий и необычный рисунок, выполненный светящимися линиями.
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Программа предназначена для создания неоновых эффектов на изображении. Подробнее…

 

AKVIS Noise Buster — Удаление цифрового шума

(Windows | Mac)

Noise Buster — программа для подавления цифрового шума.
Программа убирает шумы матрицы цифровой камеры и шумы, появляющиеся при сканировании фотоснимка,
уменьшает зернистость и устраняет неоднородные цветовые пятна на изображении, сохраняя при этом
детали и четкость границ. Подробнее…

 

AKVIS OilPaint — Эффект масляной живописи

(Windows | Mac)

AKVIS OilPaint — программа для имитации масляной живописи. Особенностью программы является
уникальный алгоритм наложения мазков, который наиболее достоверно воспроизводит технику работы
кистью. Подробнее…
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AKVIS Pastel — Рисунок пастелью из фотографии

(Windows | Mac)

AKVIS Pastel позволяет преобразовать обычный фотоснимок в рисунок, выполненный пастелью. Программа
превращает любое изображение в произведение искусства, имитируя одну из самых популярных
художественных техник, обладающую графическими и живописными свойствами. Подробнее…

 

AKVIS Points — Картины в технике пуантилизма

(Windows | Mac)

AKVIS Points превращает фотографии в картины в одной из самых выразительных живописных техник —
пуантилизм. С помощью программы Points вы с легкостью можете создавать великолепные произведения
искусства в манере пуантилистов. Откройте для себя мир ярких красок! Подробнее…
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AKVIS Refocus — Улучшение фокусировки, эффекты резкости и размытия

(Windows | Mac)

AKVIS Refocus повышает резкость нечетких фотографий, предлагает полную и выборочную фокусировку,
добавляет эффекты размытия и боке. Программа работает в пяти режимах: Исправление фокуса, Миниатюра,
Размытие диафрагмы, Размытие движения и Радиальное размытие. Подробнее…

 

AKVIS Retoucher — Восстановление и ретушь фотографий

(Windows | Mac)

AKVIS Retoucher — программа для восстановления изображений и ретуши фотографий.

Программа поможет удалить царапины, пятна, пыль, следы от сгибов и другие дефекты; убрать лишние
детали, текст;  реконструировать недостающие части фотографии, "затянуть" дырявые места и нарастить
оборванные края. Подробнее…
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AKVIS Sketch — Рисунок карандашом из фотографии

(Windows | Mac)

AKVIS Sketch — программа для создания рисунка из фотографии. Программа превращает фотоснимки в
эскизы, сделанные карандашом или углем, позволяет создать черно-белый карандашный набросок или
цветной рисунок, а также получить эффект пастели или рисунок акварельными карандашами. Подробнее…

 

AKVIS SmartMask — Выделение объекта и удаление фона
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(Windows | Mac)

AKVIS SmartMask — программа для быстрого выделения объектов на изображении. SmartMask позволяет
быстро и качественно вырезать часть фотографии, используется для удаления фона, создания коллажей.
Подробнее…

 

AKVIS Watercolor — Рисунок акварельными красками

(Windows | Mac)

AKVIS Watercolor превращает фотографию в акварельный рисунок. Благодаря многообразию настроек
можно создавать картины в самых разных жанрах: от захватывающих морских пейзажей до нежных
натюрмортов и изысканных портретов. Подробнее…
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